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Keyboard shortcuts 

To print this topic, press TAB to select Show All, press ENTER, and then press CTRL+P.  

Keys for the Office Assistant and Help window 

Display and use the Office Assistant 

To perform the following actions, the Microsoft Office Assistant must be turned on and visible. To turn on or show the Office Assistant, press 

ALT+H to open the Help menu, and then press O. With the Assistant visible, press F1 to display the Assistant balloon. 

F1  
Display the Assistant balloon (if the Assistant is turned off, F1 opens the Help window)   

In the Assistant balloon 

ALT+number   
Select a Help topic from the list the Assistant displays. ALT+1 is the first topic, ALT+2 is the second, and so on.  

ALT+DOWN ARROW  
Display more Help topics in the Assistant list  

ALT+UP ARROW  
Display previous Help topics in the Assistant list  

ESC  
Close an Assistant message or a tip 

In some wizards or dialog boxes 

TAB  

Move to the Help  button in the wizard  

SPACEBAR, with the Help  button selected   
Show the Assistant in a wizard or dialog box. To hide the Assistant, press SPACEBAR again. Note that not all wizards or dialog boxes 

have Help provided by the Assistant.  

Note   If you use a screen review utility (screen review utilities: Accessibility aids for people who are blind or have learning disabilities, such as 

dyslexia. These aids make on-screen information available as synthesized speech or a refreshable Braille display.) or other accessibility 

aid (accessibility aids: Utilities that make computers easier to use for people with disabilities. Examples of accessibility aids include screen 

readers, speech recognition programs, and on-screen keyboards. ), you'll get the best results with Help if you enter questions in the Answer 
Wizard tab in the Help window rather than in the Office Assistant balloon or in the Ask a Question box.  

Display and use the Help window 

To use the Help window, the Microsoft Office Assistant must be turned off. To turn off the Assistant, press F1 to display the Assistant. Press 

ALT+O to open the Options tab in the Office Assistant dialog box. Press ALT+U to clear the Use the Office Assistant check box, and then 

press ENTER. Press F1 to display the Help window.  

F1  
Display the Help window if the Assistant is turned off (if the Assistant is turned on, F1 displays the Assistant balloon).  

In the Help window 

F6  
Switch between the Help topic and the Contents, Answer Wizard,  Index pane (pane: A portion of the document window bounded 

by and separated from other portions by vertical or horizontal bars. )  

TAB  
Select the next hidden text or hyperlink, or Show All or Hide All at the top of a topic.  

SHIFT+TAB  
Select the previous hidden text or hyperlink, or the Browser View button at the top of a Microsoft Office Web article.  

ENTER  
Perform the action for the selected Show All, Hide All, hidden text, or hyperlink  

ALT+O  
Display the Options menu to access any Help toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To 

display a toolbar, use the Customize dialog box (point to Toolbars on the View menu and click Customize). To see more buttons, 

click Toolbar Options at the end of the toolbar.) command  

ALT+O, and then press T  
Hide or show the pane with the Contents, Answer Wizard, and Index tabs   



ALT+O, and then press B  
Display the previously viewed topic  

ALT+O, and then press F  
Display the next topic in a previously displayed sequence of topics   

ALT+O, and then press H  
Return to the specified home page  

ALT+O, and then press S  
Stop the Help window from opening a Help topic (useful if you want to stop a Web page from downloading)  

ALT+O, and then press I   
Open the Internet Options dialog box for Microsoft Internet Explorer, where you can change accessibility settings  

ALT+O, and then press R  
Refresh the topic (useful if you have linked to a Web page)  

ALT+O, and then press P  
Print all topics in a book or a selected topic only  

ALT+F4  
Close the Help window  

Note   If you use a screen review utility (screen review utilities: Accessibility aids for people who are blind or have learning disabilities, such as 

dyslexia. These aids make on-screen information available as synthesized speech or a refreshable Braille display.) or other accessibility 

aid (accessibility aids: Utilities that make computers easier to use for people with disabilities. Examples of accessibility aids include screen 

readers, speech recognition programs, and on-screen keyboards. ), you'll get the best results with Help if you enter questions in the Answer 
Wizard tab in the Help window rather than in the Office Assistant balloon or in the Ask a Question box.  

Use the Contents, Index, and Answer Wizard pane 

Press F6 to switch from the Help topic to the Contents, Answer Wizard, Index pane (pane: A portion of the document window bounded by 

and separated from other portions by vertical or horizontal bars. ). 

CTRL+TAB  
Switch to the next tab  

ALT+C  
Switch to the Contents tab  

ALT+A  
Switch to the Answer Wizard tab  

ALT+I  
Switch to the Index tab  

ENTER  
Open a selected book or Help topic  

DOWN ARROW  
Select the next book or Help topic  

UP ARROW  
Select the previous book or Help topic  

SHIFT+F10  
Display a shortcut menu  

Note   If you use a screen review utility (screen review utilities: Accessibility aids for people who are blind or have learning disabilities, such as 

dyslexia. These aids make on-screen information available as synthesized speech or a refreshable Braille display.) or other accessibility 

aid (accessibility aids: Utilities that make computers easier to use for people with disabilities. Examples of accessibility aids include screen 

readers, speech recognition programs, and on-screen keyboards. ), you'll get the best results with Help if you enter questions in the Answer 
Wizard tab in the Help window rather than in the Microsoft Office Assistant balloon or in the Ask a Question box.  

Use the Help topic pane 

Press F6 to switch from the Contents, Answer Wizard, Index pane (pane: A portion of the document window bounded by and separated from 

other portions by vertical or horizontal bars. ) to the open Help topic. 

ALT+RIGHT ARROW  
Go to the next Help topic  

ALT+LEFT ARROW  
Go to the previous Help topic  

TAB  
Select the next hidden text or hyperlink, or Show All or Hide All at the top of a topic.  

SHIFT+TAB  
Select the previous hidden text or hyperlink, or the Browser View button at the top of a Microsoft Office Web article.  

ENTER  
Perform the action for the selected Show All, Hide All, hidden text, or hyperlink  



UP ARROW or DOWN ARROW  
Scroll toward the beginning or end of a Help topic  

PAGE UP or PAGE DOWN  
Scroll toward the beginning or end of a Help topic in large increments  

HOME or END  
Go to the beginning or end of a Help topic  

CTRL+P  
Print the current Help topic  

CTRL+A  
Select the entire Help topic  

CTRL+C  
Copy the selected items to the Clipboard  

SHIFT+F10  
Display a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut 

menu, right-click an item or press SHIFT+F10.)  

Keys for the Office interface 

Display and use windows 

ALT+TAB  
Switch to the next program.  

ALT+SHIFT+TAB  
Switch to the previous program.  

CTRL+ESC  
Display the Windows Start menu.  

CTRL+W or CTRL+F4  
Close the selected workbook window.  

CTRL+F5  
Restore the window size of the selected workbook window.  

F6  
Switch to the next pane in a worksheet that has been split (Window menu, Split command).  

SHIFT+F6  
Switch to the previous pane in a worksheet that has been split.  

CTRL+F6  
When more than one workbook window is open, switch to the next workbook window.  

CTRL+SHIFT+F6  
Switch to the previous workbook window.  

CTRL+F7  
When a workbook window is not maximized, perform the Move command (on the Control menu for the workbook window). Use the 

arrow keys to move the window, and when finished press ESC.  

CTRL+F8  
When a workbook window is not maximized, perform the Size command (on the Control menu for the workbook window). Use the 

arrow keys to resize the window, and when finished press ESC.  

CTRL+F9  
Minimize a workbook window to an icon.  

CTRL+F10  
Maximize or restore the selected workbook window.  

PRTSCR  
Copy a picture of the screen to the Clipboard.  

ALT+PRINT SCREEN  
Copy a picture of the selected window to the Clipboard.  

Access and use smart tags 

ALT+SHIFT+F10  
Display the menu or message for a smart tag. If more than one smart tag is present, switch to the next smart tag and display its menu 

or message.  

DOWN ARROW  
Select the next item in a smart tag menu.  

UP ARROW  
Select the previous item in a smart tag menu.  



ENTER  
Perform the action for the selected item in a smart tag menu.  

ESC  
Close the smart tag menu or message.  

Tip 

You can ask to be notified by a sound whenever a smart tag appears. To hear audio cues, you must have a sound card. You must also have 

Microsoft Office Sounds installed on your computer.  

If you have access to the World Wide Web, you can download Microsoft Office Sounds from the Microsoft Office Web site. On the Help 

menu, click Office on the Web and search for "Microsoft Office Sounds." After you've installed the sound files, you need to select the 

Provide feedback with sound check box on the General tab of the Options dialog box (Tools menu). When you select (or clear) this 

check box, the setting affects all Office programs that support sound.  

Note   The hyperlinks  (hyperlink: Colored and underlined text or a graphic that you click to go to a file, a location in a file, an HTML page on 

the World Wide Web, or an HTML page on an intranet. Hyperlinks can also go to newsgroups and to Gopher, Telnet, and FTP sites.)in this 

topic goes to the Web. You can switch back to Help at any time.  

Access and use task panes 

F6  
Move to a task pane (task pane: A window within an Office application that provides commonly used commands. Its location and small 

size allow you to use these commands while still working on your files.) from another pane in the program window. (You may need to 

press F6 more than once.)  

Note   If pressing F6 doesn't display the task pane you want, try pressing ALT to place focus on the menu bar, and then pressing 

CTRL+TAB to move to the task pane.  

CTRL+TAB  
When a menu or toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To display a toolbar, use the 

Customize dialog box (point to Toolbars on the View menu and click Customize). To see more buttons, click Toolbar Options at 

the end of the toolbar.) is active, move to a task pane. (You may need to press CTRL+TAB more than once.)  

TAB or SHIFT+TAB   
When a task pane is active, select the next or previous option in the task pane  

CTRL+DOWN ARROW  
Display the full set of commands on the task pane menu  

DOWN ARROW or UP ARROW  
Move among choices in a selected submenu; move among certain options in a group of options  

SPACEBAR or ENTER  
Open the selected menu, or perform the action assigned to the selected button  

SHIFT+F10  
Open a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut menu, 

right-click an item or press SHIFT+F10.); open a drop-down menu for the selected gallery item  

HOME or END   
When a menu or submenu is visible, select the first or last command on the menu or submenu  

PAGE UP or PAGE DOWN  
Scroll up or down in the selected gallery list  

CTRL+HOME or CTRL+END  
Move to the top or bottom of the selected gallery list  

Access and use menus and toolbars 

F10 or ALT  
Select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of menus. A menu bar can be the built-in 

menu bar or a custom menu bar.), or close an open menu and submenu at the same time.  

TAB or SHIFT+TAB  
When a toolbar is selected, select the next or previous button or menu on the toolbar.  

CTRL+TAB or CTRL+SHIFT+TAB  
When a toolbar is selected, select the next or previous toolbar.  

ENTER  
Open the selected menu, or perform the action for the selected button or command.  

SHIFT+F10  
Display the shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut 

menu, right-click an item or press SHIFT+F10.) for the selected item.  

ALT+SPACEBAR  
Display the Control menu for the Excel window.  

DOWN ARROW or UP ARROW  
When a menu or submenu is open, select the next or previous command.  



LEFT ARROW or RIGHT ARROW  
Select the menu to the left or right. When a submenu is open, switch between the main menu and the submenu.  

HOME or END  
Select the first or last command on the menu or submenu.  

ESC  
Close an open menu. When a submenu is open, close only the submenu.  

CTRL+DOWN ARROW  
Display the full set of commands on a menu.  

CTRL+7  
Show or hide the Standard toolbar.  

Note   You can select any menu command on the menu bar or on a displayed toolbar with the keyboard. To select the menu bar, press ALT. 

Then to select a toolbar, press CTRL+TAB repeatedly until you select the toolbar you want. Press the underlined letter in the menu that contains 

the command you want. In the menu that appears, press the underlined letter in the command that you want. 

Resize and move toolbars and task panes 

1. Press ALT to select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of menus. A menu bar can 

be the built-in menu bar or a custom menu bar.).  

2. Press CTRL+TAB repeatedly to select the toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To 

display a toolbar, use the Customize dialog box (point to Toolbars on the View menu and click Customize). To see more buttons, 

click Toolbar Options at the end of the toolbar.) or task pane (task pane: A window within an Office application that provides 

commonly used commands. Its location and small size allow you to use these commands while still working on your files.) you want.  

3. Do one of the following:  

Resize a toolbar 

1. In the toolbar, press CTRL+SPACE to display the Toolbar Options menu.  

2. Select the Size command, and then press ENTER.  

3. Use the arrow keys to resize the toolbar.  

Move a toolbar 

1. In the toolbar, press CTRL+SPACE to display the Toolbar Options menu.  

2. Select the Move command, and then press ENTER.  

3. Use the arrow keys to position the toolbar. Press CTRL+ the arrow keys to move one pixel at a time. To undock the toolbar, press 

DOWN ARROW repeatedly. To dock the toolbar vertically on the left or right side, press LEFT ARROW or RIGHT ARROW respectively 

when the toolbar is all the way to the left or right side.  

Resize a task pane 

1. In the task pane, press CTRL+SPACE to display a menu of additional commands.  

2. Use the DOWN ARROW key to select the Size command, and then press ENTER.  

3. Use the arrow keys to resize the task pane. Use CTRL+ the arrow keys to resize by one pixel at a time.  

Move a task pane 

1. In the task pane, press CTRL+SPACE to display a menu of additional commands.  

2. Use the DOWN ARROW key to select the Move command, and then press ENTER.  

3. Use the arrow keys to position the task pane. Use CTRL+ the arrow keys to move one pixel at a time.  

4. When you are finished moving or resizing, press ESC.  

Use dialog boxes 

TAB  
Move to the next option or option group.  

SHIFT+TAB  
Move to the previous option or option group.  

CTRL+TAB or CTRL+PAGE DOWN  
Switch to the next tab in a dialog box.  

CTRL+SHIFT+TAB or CTRL+PAGE UP  
Switch to the previous tab in a dialog box.  

Arrow keys  
Move between options in an open drop-down list, or between options in a group of options.  

SPACEBAR  
Perform the action for the selected button, or select or clear the selected check box.  

First letter of an option in a drop-down list  
Open the list if it is closed and move to that option in the list.  



ALT+ the underlined letter in an option  
Select an option, or select or clear a check box.  

ALT+DOWN ARROW  
Open the selected drop-down list.  

ENTER  
Perform the action for the default command button in the dialog box (the button with the bold outline, often the OK button).  

ESC  
Cancel the command and close the dialog box.  

Use edit boxes within dialog boxes 

An edit box is a blank in which you type or paste an entry, such as your user name or the path (path: The route the operating system uses to 

locate a folder or file; for example, C:\House finances\March.doc.) to a folder. 

HOME  
Move to the beginning of the entry.  

END  
Move to the end of the entry.  

LEFT ARROW or RIGHT ARROW  
Move one character to the left or right.  

CTRL+LEFT ARROW  
Move one word to the left.  

CTRL+RIGHT ARROW  
Move one word to the right.  

SHIFT+LEFT ARROW  
Select or unselect one character to the left.  

SHIFT+RIGHT ARROW  
Select or unselect one character to the right.  

CTRL+SHIFT+LEFT ARROW  
Select or unselect one word to the left.  

CTRL+SHIFT+RIGHT ARROW  
Select or unselect one word to the right.  

SHIFT+HOME  
Select from the insertion point to the beginning of the entry.  

SHIFT+END  
Select from the insertion point to the end of the entry.  

Use the Open, Save As, and Insert Picture dialog boxes 

The Open, Insert Picture, and Save As dialog boxes support standard dialog box keyboard shortcuts. (To view standard shortcuts for dialog 

boxes, refer to the Use Dialog Boxes and Use Edit Boxes Within Dialog Boxes sections in the main Keyboard Shortcuts topic.) These dialog 

boxes also support the shortcuts below. 

ALT+1  

Go to the previous folder   

ALT+2  

Up One Level  button: open the folder up one level above the open folder  

ALT+3  

Search the Web  button: close the dialog box and open your Web search page (search page: A page from which you can find and 

go to other Internet sites or to documents on an intranet. Many search pages provide various ways to search, such as by topic, by 

keyword, or by matches to user queries.)  

ALT+4  

Delete  button: delete the selected folder or file  

ALT+5  

Create New Folder  button: create a new folder  

ALT+6  

Views  button: switch among available folder views  

ALT+7 or ALT+L  
Tools button: show the Tools menu   

SHIFT+F10  



Display a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut 

menu, right-click an item or press SHIFT+F10.) for a selected item such as a folder or file  

TAB  
Move between options or areas in the dialog box   

F4 or ALT+I  
Open the Look in list  

F5  
Refresh the file list  

Keys for workbooks and worksheets 

Preview and print 

CTRL+P or CTRL+SHIFT+F12  
Display the Print dialog box.  

Use the following keys in print preview (to get to print preview, press ALT+F, then press V): 

Arrow keys  
Move around the page when zoomed in.  

PAGE UP or PAGE DOWN  
Move by one page when zoomed out.  

CTRL+UP ARROW or CTRL+LEFT ARROW  
Move to the first page when zoomed out.  

CTRL+DOWN ARROW or CTRL+RIGHT ARROW  
Move to the last page when zoomed out.  

Work with worksheets 

SHIFT+F11 or ALT+SHIFT+F1  
Insert a new worksheet.  

CTRL+PAGE DOWN  
Move to the next sheet in the workbook.  

CTRL+PAGE UP  
Move to the previous sheet in the workbook.  

SHIFT+CTRL+PAGE DOWN  
Select the current and next sheet. To cancel selection of multiple sheets, press CTRL+PAGE DOWN or, to select a different sheet, press 

CTRL+PAGE UP.  

SHIFT+CTRL+PAGE UP  
Select the current and previous sheet.  

ALT+O H R  
Rename the current sheet (Format menu, Sheet submenu, Rename command).  

ALT+E M  
Move or copy the current sheet (Edit menu, Move or Copy Sheet command).  

ALT+E L  
Delete the current sheet (Edit menu, Delete Sheet command).  

Move and scroll within worksheets 

Arrow keys  
Move one cell up, down, left, or right.  

CTRL+arrow key  
Move to the edge of the current data region (data region: A range of cells that contains data and that is bounded by empty cells or 

worksheet borders.).  

HOME  
Move to the beginning of the row.  

CTRL+HOME  
Move to the beginning of the worksheet.  

CTRL+END  
Move to the last cell on the worksheet, in the bottom-most used row of the rightmost used column.  

PAGE DOWN  
Move down one screen.  

PAGE UP  



Move up one screen.  

ALT+PAGE DOWN  
Move one screen to the right.  

ALT+PAGE UP  
Move one screen to the left.  

F6  
Switch to the next pane in a worksheet that has been split (Window menu, Split command).  

SHIFT+F6  
Switch to the previous pane in a worksheet that has been split.  

CTRL+BACKSPACE  
Scroll to display the active cell.  

F5  
Display the Go To dialog box.  

SHIFT+F5  
Display the Find dialog box.  

SHIFT+F4  
Repeat the last Find action (same as Find Next).  

TAB  
Move between unlocked cells on a protected worksheet.  

Move within a selected range 

ENTER  
Move from top to bottom within the selected range.  

SHIFT+ENTER  
Move from bottom to top within the selected range.  

TAB  
Move from left to right within the selected range. If cells in a single column are selected, move down.  

SHIFT+TAB  
Move from right to left within the selected range. If cells in a single column are selected, move up.  

CTRL+PERIOD  
Move clockwise to the next corner of the selected range.  

CTRL+ALT+RIGHT ARROW  
In nonadjacent selections, switch to the next selection to the right.  

CTRL+ALT+LEFT ARROW  
Switch to the next nonadjacent selection to the left.  

Note   You can change the direction of movement after pressing ENTER or SHIFT+ENTER: press ALT+T and then O (Tools menu, Options 
command), press CTRL+TAB until the Edit tab is selected, and then change the Move selection after Enter settings. 

Move and scroll in End mode 

END appears in the status bar when End mode is selected. 

END key  
Turn End mode on or off.  

END+arrow key  
Move by one block of data within a row or column.  

END+HOME  
Move to the last cell on the worksheet, in the bottom-most used row of the rightmost used column.  

END+ENTER  
Move to the rightmost nonblank cell in the current row. This key sequence does not work if you have turned on transition navigation 

keys (Tools menu, Options command, Transition tab).  

Move and scroll with SCROLL LOCK on 

When you use scrolling keys (such as PAGE UP and PAGE DOWN) with SCROLL LOCK off, cell selection moves the distance you scroll. To 

scroll without changing which cells are selected , turn on SCROLL LOCK first. 

SCROLL LOCK  
Turn SCROLL LOCK on or off.  

HOME  
Move to the cell in the upper-left corner of the window.  

END  



Move to the cell in the lower-right corner of the window.  

UP ARROW or DOWN ARROW  
Scroll one row up or down.  

LEFT ARROW or RIGHT ARROW  
Scroll one column left or right.  

Keys for selecting data and cells 

Select cells, rows and columns, and objects 

CTRL+SPACEBAR  
Select the entire column.  

SHIFT+SPACEBAR  
Select the entire row.  

CTRL+A  
Select the entire worksheet.  

SHIFT+BACKSPACE  
With multiple cells selected, select only the active cell.  

CTRL+SHIFT+SPACEBAR  
With an object selected, select all objects on a sheet.  

CTRL+6  
Alternate between hiding objects, displaying objects, and displaying placeholders for objects.  

Select cells with specific characteristics 

CTRL+SHIFT+* (asterisk)  
Select the current region around the active cell (the data area enclosed by blank rows and blank columns). In a PivotTable report, select 

the entire PivotTable report.  

CTRL+/  
Select the array (array: Used to build single formulas that produce multiple results or that operate on a group of arguments that are 

arranged in rows and columns. An array range shares a common formula; an array constant is a group of constants used as an 

argument.) containing the active cell.  

CTRL+SHIFT+O (the letter O)  
Select all cells that contain comments.  

CTRL+\  
In a selected row, select the cells that don't match the value in the active cell.  

CTRL+SHIFT+|  
In a selected column, select the cells that don't match the value in the active cell.  

CTRL+[ (opening bracket)  
Select all cells directly referenced by formulas in the selection.  

CTRL+SHIFT+{ (opening brace)  
Select all cells directly or indirectly referenced by formulas in the selection.  

CTRL+] (closing bracket)  
Select cells that contain formulas that directly reference the active cell.  

CTRL+SHIFT+} (closing brace)  
Select cells that contain formulas that directly or indirectly reference the active cell.  

ALT+; (semicolon)  
Select the visible cells in the current selection.  

Extend a selection 

F8  
Turn extend mode on or off. In extend mode, EXT appears in the status line, and the arrow keys extend the selection.  

SHIFT+F8  
Add another range of cells to the selection; or use the arrow keys to move to the start of the range you want to add, and then press F8 

and the arrow keys to select the next range.  

SHIFT+arrow key  
Extend the selection by one cell.  

CTRL+SHIFT+arrow key  
Extend the selection to the last nonblank cell in the same column or row as the active cell.  

SHIFT+HOME  
Extend the selection to the beginning of the row.  

CTRL+SHIFT+HOME  



Extend the selection to the beginning of the worksheet.  

CTRL+SHIFT+END  
Extend the selection to the last used cell on the worksheet (lower-right corner).  

SHIFT+PAGE DOWN  
Extend the selection down one screen.  

SHIFT+PAGE UP  
Extend the selection up one screen.  

END+SHIFT+arrow key  
Extend the selection to the last nonblank cell in the same column or row as the active cell.  

END+SHIFT+HOME  
Extend the selection to the last used cell on the worksheet (lower-right corner).  

END+SHIFT+ENTER  
Extend the selection to the last cell in the current row. This key sequence does not work if you have turned on transition navigation keys 

(Tools menu, Options command, Transition tab).  

SCROLL LOCK+SHIFT+HOME  
Extend the selection to the cell in the upper-left corner of the window.  

SCROLL LOCK+SHIFT+END  
Extend the selection to the cell in the lower-right corner of the window.  

Keys for entering, editing, formatting, and calculating data 

Enter data 

ENTER  
Complete a cell entry and select the cell below.  

ALT+ENTER  
Start a new line in the same cell.  

CTRL+ENTER  
Fill the selected cell range with the current entry.  

SHIFT+ENTER  
Complete a cell entry and select the previous cell above.  

TAB  
Complete a cell entry and select the next cell to the right.  

SHIFT+TAB  
Complete a cell entry and select the previous cell to the left.  

ESC  
Cancel a cell entry.  

Arrow keys  
Move one character up, down, left, or right.  

HOME  
Move to the beginning of the line.  

F4 or CTRL+Y  
Repeat the last action.  

CTRL+SHIFT+F3  
Create names (name: A word or string of characters that represents a cell, range of cells, formula, or constant value. Use easy to 

understand names, such as Products to refer to hard to understand ranges, such as Sales!C20:C30.) from row and column labels.  

CTRL+D  
Fill down.  

CTRL+R  
Fill to the right.  

CTRL+F3  
Define a name.  

CTRL+K  
Insert a hyperlink (hyperlink: Colored and underlined text or a graphic that you click to go to a file, a location in a file, an HTML page on 

the World Wide Web, or an HTML page on an intranet. Hyperlinks can also go to newsgroups and to Gopher, Telnet, and FTP sites.).  

ENTER (in a cell with a hyperlink)  
Activate a hyperlink.  

CTRL+; (semicolon)  
Enter the date.  

CTRL+SHIFT+: (colon)  
Enter the time.  

ALT+DOWN ARROW  



Display a drop-down list of the values in the current column of a list (list: A series of worksheet rows that contain related data, such as 

an invoice database or a set of client names and phone numbers. The first row of the list has labels for the columns.).  

CTRL+Z  
Undo the last action.  

Enter special characters 

Press F2 to edit the cell, turn on NUM LOCK, and then press the following keys by using the numeric key pad: 

ALT+0162  
Enters the cent character ¢.  

ALT+0163  
Enters the pound sterling character £.  

ALT+0165  
Enters the yen symbol ¥.  

ALT+0128  
Enters the euro symbol €.  

Enter and calculate formulas 

= (equal sign)  
Start a formula.  

F2  
Move the insertion point into the Formula Bar when editing in a cell is turned off.  

BACKSPACE  
In the Formula Bar, delete one character to the left.  

ENTER  
Complete a cell entry from the cell or Formula Bar.  

CTRL+SHIFT+ENTER  
Enter a formula as an array formula (array formula: A formula that performs multiple calculations on one or more sets of values, and 

then returns either a single result or multiple results. Array formulas are enclosed between braces { }, and are entered by pressing 

CTRL+SHIFT+ENTER.).  

ESC  
Cancel an entry in the cell or Formula Bar.  

SHIFT+F3  
In a formula, display the Insert Function dialog box.  

CTRL+A  
When the insertion point is to the right of a function name in a formula, display the Function Arguments dialog box.  

CTRL+SHIFT+A  
When the insertion point is to the right of a function name in a formula, insert the argument names and parentheses.  

F3  
Paste a defined name (name: A word or string of characters that represents a cell, range of cells, formula, or constant value. Use easy 

to understand names, such as Products to refer to hard to understand ranges, such as Sales!C20:C30.) into a formula.  

ALT+= (equal sign)  
Insert an AutoSum formula with the SUM function.  

CTRL+SHIFT+" (quotation mark)  
Copy the value from the cell above the active cell into the cell or the Formula Bar.  

CTRL+' (apostrophe)  
Copies a formula from the cell above the active cell into the cell or the Formula Bar.  

CTRL+` (single left quotation mark)  
Alternate between displaying cell values and displaying formulas.  

F9  
Calculate all worksheets in all open workbooks.  

When a portion of a formula is selected, calculate the selected portion. You can then press ENTER or CTRL+SHIFT+ENTER (for array 

formulas) to replace the selected portion with the calculated value.  

SHIFT+F9  
Calculate the active worksheet.  

CTRL+ALT+F9  
Calculate all worksheets in all open workbooks, regardless of  whether they have changed since the last calculation.  

CTRL+ALT+SHIFT+F9  
Rechecks dependent formulas and then calculates all cells in all open workbooks, including cells not marked as needing to be calculated. 



Edit data 

F2  
Edit the active cell and position the insertion point at the end of the cell contents.  

ALT+ENTER  
Start a new line in the same cell.  

BACKSPACE  
Edit the active cell and then clear it, or delete the preceding character in the active cell as you edit cell contents.  

DELETE  
Delete the character to the right of the insertion point, or delete the selection.  

CTRL+DELETE  
Delete text to the end of the line.  

F7  
Display the Spelling dialog box.  

SHIFT+F2  
Edit a cell comment.  

ENTER  
Complete a cell entry and select the next cell below.  

CTRL+Z  
Undo the last action.  

ESC  
Cancel a cell entry.  

CTRL+SHIFT+Z  
When the AutoCorrect Smart Tags is displayed, undo or redo the last automatic correction.  

Insert, delete, and copy cells 

CTRL+C  
Copy the selected cells.  

CTRL+C, immediately followed by another CTRL+C  
Display the Microsoft Office Clipboard (multiple copy and paste).  

CTRL+X  
Cut the selected cells.  

CTRL+V  
Paste copied cells.  

DELETE  
Clear the contents of the selected cells.  

CTRL+HYPHEN  
Delete the selected cells.  

CTRL+SHIFT+PLUS SIGN  
Insert blank cells.  

Format data 

ALT+' (apostrophe)  
Display the Style dialog box.  

CTRL+1  
Display the Format Cells dialog box.  

CTRL+SHIFT+~  
Apply the General number format.  

CTRL+SHIFT+$  
Apply the Currency format with two decimal places (negative numbers in parentheses).  

CTRL+SHIFT+%  
Apply the Percentage format with no decimal places.  

CTRL+SHIFT+^  
Apply the Exponential number format with two decimal places.  

CTRL+SHIFT+#  
Apply the Date format with the day, month, and year.  

CTRL+SHIFT+@  
Apply the Time format with the hour and minute, and AM or PM.  



CTRL+SHIFT+!  
Apply the Number format with two decimal places, thousands separator, and minus sign (–) for negative values.  

CTRL+B  
Apply or remove bold formatting.  

CTRL+I  
Apply or remove italic formatting.  

CTRL+U  
Apply or remove underlining.  

CTRL+5  
Apply or remove strikethrough.  

CTRL+9  
Hide the selected rows.  

CTRL+SHIFT+( (opening parenthesis)  
Unhide any hidden rows within the selection.  

CTRL+0 (zero)  
Hide the selected columns.  

CTRL+SHIFT+) (closing parenthesis)  
Unhide any hidden columns within the selection.  

CTRL+SHIFT+&  
Apply the outline border to the selected cells.  

CTRL+SHIFT+_  
Remove the outline border from the selected cells.  

Use the Border tab in the Format Cells dialog box 

Press CTRL+1 to display this dialog box.  

ALT+T  
Apply or remove the top border.  

ALT+B  
Apply or remove the bottom border.  

ALT+L  
Apply or remove the left border.  

ALT+R  
Apply or remove the right border.  

ALT+H  
If cells in multiple rows are selected, apply or remove the horizontal divider.  

ALT+V  
If cells in multiple columns are selected, apply or remove the vertical divider.  

ALT+D  
Apply or remove the downward diagonal border.  

ALT+U  
Apply or remove the upward diagonal border.  

Keys for filtering, outlining, and managing lists 

Use data forms (Data menu, Form command) 

DOWN ARROW  
Move to the same field in the next record.  

UP ARROW  
Move to the same field in the previous record.  

TAB and SHIFT+TAB  
Move to each field in the record, then to each command button.  

ENTER  
Move to the first field in the next record.  

SHIFT+ENTER  
Move to the first field in the previous record.  

PAGE DOWN  
Move to the same field 10 records forward.  

CTRL+PAGE DOWN  
Start a new, blank record.  



PAGE UP  
Move to the same field 10 records back.  

CTRL+PAGE UP  
Move to the first record.  

HOME or END  
Move to the beginning or end of a field.  

SHIFT+END  
Extend selection to the end of a field.  

SHIFT+HOME  
Extend selection to the beginning of a field.  

LEFT ARROW or RIGHT ARROW  
Move one character left or right within a field.  

SHIFT+LEFT ARROW  
Select the character to the left within a field.  

SHIFT+RIGHT ARROW  
Select the character to the right within a field.  

Filter lists (Data menu, AutoFilter command) 

ALT+DOWN ARROW  
In the cell that contains the drop-down arrow, displays the AutoFilter list for the current column.  

DOWN ARROW  
Selects the next item in the AutoFilter list.  

UP ARROW  
Selects the previous item in the AutoFilter list.  

ALT+UP ARROW  
Closes the AutoFilter list for the current column.  

HOME  
Selects the first item (All) in the AutoFilter list.  

END  
Selects the last item in the AutoFilter list.  

ENTER  
Filters the list based on the item selected from the AutoFilter list.  

Show, hide, and outline data 

ALT+SHIFT+RIGHT ARROW  
Groups rows or columns.  

ALT+SHIFT+LEFT ARROW  
Ungroups rows or columns.  

CTRL+8  
Displays or hides the outline symbols.  

CTRL+9  
Hides the selected rows.  

CTRL+SHIFT+( (opening parenthesis)  
Unhides any hidden rows within the selection.  

CTRL+0 (zero)  
Hides the selected columns.  

CTRL+SHIFT+) (closing parenthesis)  
Unhides any hidden columns within the selection.  

Keys for PivotTable and PivotChart reports 

Lay out a report onscreen 

1. Press F10 to make the menu bar active.  

2. Press CTRL+TAB or CTRL+SHIFT+TAB to make the PivotTable Field List active.  

3. Press the DOWN ARROW or UP ARROW key to select the field you want. Press RIGHT ARROW or LEFT ARROW to open or close a field 

that can be expanded.  

4. Press TAB to select the Add To list, and then press DOWN ARROW to open the list.  

5. Press DOWN ARROW or UP ARROW to select the area where you want to move the field, and then press ENTER.  

6. Press TAB to select the Add To button, and then press ENTER.  



Use the PivotTable and PivotChart Wizard – Layout dialog box 

To display this dialog box, press TAB until Layout is selected in Step 3 of the PivotTable and PivotChart Wizard. 

UP ARROW or DOWN ARROW  
Selects the previous or next field button in the list on the right.  

LEFT ARROW or RIGHT ARROW  
With two or more columns of field buttons, selects the button to the left or right.  

ALT+R  
Moves the selected field into the Row area.  

ALT+C  
Moves the selected field into the Column area.  

ALT+D  
Moves the selected field into the Data area.  

ALT+P  
Moves the selected field into the Page area.  

ALT+L  
Displays the PivotTable Field dialog box for the selected field.  

Display and hide items in a field 

ALT+DOWN ARROW  
Displays the drop-down list for a field in a PivotTable or PivotChart report. Use the arrow keys to select the field.  

UP ARROW  
Selects the previous item in the list.  

DOWN ARROW  
Selects the next item in the list.  

RIGHT ARROW  
For an item that has lower-level items available, displays the lower-level items.  

LEFT ARROW  
For an item that has lower-level items displayed, hides the lower-level items.  

HOME  
Selects the first visible item in the list.  

END  
Selects the last visible item in the list.  

ENTER  
Closes the list and displays the selected items.  

SPACEBAR  
Checks, double-checks, or clears a check box in the list. Double-check selects both an item and all of its llower-level items.  

TAB  
Switches between the list, the OK button, and the Cancel button.  

Change the layout of a report 

CTRL+SHIFT+* (asterisk)  
Selects an entire PivotTable report.  

ALT+SHIFT+RIGHT ARROW  
Groups the selected items in a PivotTable field.  

ALT+SHIFT+LEFT ARROW  
Ungroups grouped items in a PivotTable field.  

Keys for charts 

Create charts and select chart elements 

F11 or ALT+F1  
Creates a chart of the data in the current range.  

CTRL+PAGE DOWN  
Selects a chart sheet: selects the next sheet in the workbook, until the chart sheet you want is selected.  

CTRL+PAGE UP  
Selects a chart sheet: selects the previous sheet in the workbook, until the chart sheet you want is selected.  

DOWN ARROW  
Select the previous group of elements in a chart.  



UP ARROW  
Selects the next group of elements in a chart.  

RIGHT ARROW  
Selects the next element within a group.  

LEFT ARROW  
Selects the previous element within a group.  

Select an embedded chart 

1. Display the Drawing toolbar: Press ALT+V, press T, press DOWN ARROW until Drawing is selected, and then press ENTER.  

2. Press F10 to make the menu bar active.  

3. Press CTRL+TAB or CTRL+SHIFT+TAB to select the Drawing toolbar.  

4. Press the RIGHT ARROW key to select the Select Objects  button on the Drawing toolbar.  

5. Press CTRL+ENTER to select the first object.  

6. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until round sizing handles (sizing handle: One 

of the small circles or squares that appears at the corners and sides of a selected object. You drag these handles to change the size of 

the object.) appear on the embedded chart you want to select.  

7. Press CTRL+ENTER to make the chart active so that you can select elements within it.  

Keys for drawing objects and other objects 

When both the Reviewing and Drawing toolbars are onscreen, ALT+U switches between the Review command and the AutoShapes 
command, and ENTER performs the selected command. 

Select a drawing object 

When you're editing text in a drawing object, you can select the next or previous object by pressing TAB or SHIFT+TAB. Starting from a 

worksheet, do the following: 

1. Press F10, press CTRL+TAB to select the Drawing toolbar, and then press RIGHT ARROW to select the Select Objects  button.  

2. Press CTRL+ENTER to select the first drawing object.  

3. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until sizing handles appear on the object you 

want to select. 

If an object is grouped, TAB selects the group, then each object within the group, and then the next object.  

4. To switch back to the worksheet when an object is selected, press ESC.  

Insert an AutoShape 

1. Press ALT+U to select the AutoShapes menu on the Drawing toolbar.  

2. Use the arrow keys to move to the category of AutoShapes you want, and then press the RIGHT ARROW key.  

3. Use the arrow keys to select the AutoShape you want.  

4. Press CTRL+ENTER.  

5. To format the AutoShape, press CTRL+1 to display the Format AutoShape dialog box.  

Insert a text box 

1. Press F10, press CTRL+TAB to select the Drawing toolbar, and then press RIGHT ARROW to select the Text Box  button.  

2. Press CTRL+ENTER.  

3. Type the text you want in the text box.  

4. Do one of the following: 

To return to the worksheet when you are finished typing, press ESC twice. 

To format the text box, press ESC, and then press CTRL+1 to display the Format Text Box dialog box. When you finish formatting, 

press ENTER, and then press ESC to return to the worksheet.  

Insert WordArt 

1. Press ALT+I, then press P, then press W (Insert menu, Picture submenu, WordArt command).  

2. Use the arrow keys to select the WordArt style you want, and then press ENTER.  

3. Type the text you want, and then use the TAB key to select other options in the dialog box.  

4. Press ENTER to insert the WordArt object.  

5. To format the WordArt object, use the tools on the Word Art toolbar, or press CTRL+1 to display the Format WordArt dialog box.  

Rotate a drawing object 

1. Select the drawing object you want to rotate.  



2. Press CTRL+1 to display the Format menu for the object, and then press CTRL+TAB to select the Size tab.  

3. Press ALT+T to select the Rotation box.  

4. Use the arrow keys to select the amount of rotation you want.  

Change the size of a drawing object 

1. Select the drawing object you want to resize.  

2. Press CTRL+1 to display the Format menu for the object, and then press CTRL+TAB to select the Size tab.  

3. Select the options you want to change the size.  

Move a drawing object 

1. Select the drawing object you want to move.  

2. Press the arrow keys to move the object.  

3. To position the object precisely, press CTRL+ an arrow key to move the object in one-pixel increments.  

Copy drawing objects and their attributes 

To make a copy of a drawing object, select the object and press CTRL+D. To copy attributes such as fill color and line style from one object 

to another, do the following: 

1. Select the drawing object with the attributes you want to copy. 

For AutoShapes with text, the text format is copied along with the other attributes.  

2. Press CTRL+SHIFT+C to copy the object attributes.  

3. Press TAB or SHIFT+TAB to select the object you want to copy the attributes to.  

4. Press CTRL+SHIFT+V to copy the attributes to the object.  

Keys for use with speech, e-mail, macros, and other languages 

Use speech recognition and text-to-speech 

CTRL  
Switches between command mode and dictation mode.  

ESC  
Stops reading when text is being read aloud.  

Send e-mail messages 

To use keys to send e-mail messages, you must configure Microsoft Outlook as your default e-mail program. Most of these keys do not work 

with Outlook Express.  

SHIFT+TAB  
When cell A1 is selected, moves to the Introduction box in the e-mail message header. In the message header, moves to the 

Subject, Bcc (if displayed), Cc, To, and From (if displayed) boxes, then to the address book for the Bcc, Cc, To, and From boxes, 

and then to cell A1.  

ALT+S  
Sends the e-mail message.  

CTRL+SHIFT+B  
Opens the Address Book.  

ALT+O  
Opens the Options menu for access to the Options, Bcc Field, and From Field commands.  

ALT+P  
Opens the Outlook Message Options dialog box (Options menu, Options command).  

ALT+K  
Checks the names in the To, Cc, and Bcc boxes against the Address Book.  

ALT+PERIOD  
Opens the Address Book for the To box.  

ALT+C  
Opens the Address Book for the Cc box.  

ALT+B  
If the Bcc box is displayed, opens the Address Book for the Bcc box.  

ALT+J  
Goes to the Subject box.  

CTRL+SHIFT+G  
Creates a message flag.  

ALT+A  



Adds interactivity to the range or sheet being sent.  

Work with macros 

ALT+F8  
Displays the Macro dialog box.  

ALT+F11  
Displays the Visual Basic Editor.  

CTRL+F11  
Inserts a Microsoft Excel 4.0 macro sheet.  

Work with multiple national languages 

CTRL+RIGHT SHIFT  
Switches to right-to-left paragraph direction (the text must contain only neutral characters (neutral characters: Characters that do not 

have strong right-to-left or left-to-right language attributes. Numerals are an example of neutral characters.)).  

CTRL+LEFT SHIFT  
Switches to left-to-right paragraph direction (the text must contain only neutral characters).  

ALT+SHIFT+UP ARROW  
In Japanese text for which you've displayed phonetic guides, moves the pointer into the phonetic guides.  

ALT+SHIFT+DOWN ARROW  
Moves the pointer from the phonetic guides back to the parent string of characters.  

NUM LOCK, ALT+numeric pad numbers  
Enter a unicode character.  

ALT+X  
Pressed immediately after typing the hexadecimal code for a unicode character, converts the numbers to the character. 

Pressed immediately following a unicode character, converts the character to its hexadecimal code.  


